Advising Technology for the  
Technologically Challenged Advisor  

The “How Tos” and “Why Bothers” Concerning Adopting Web-based Applications for Advising  

Terry Musser, The Pennsylvania State University  
Art Esposito, Virginia Commonwealth University  
Wes Lipschultz, The University of Pittsburgh  

Introduction  

The following guides have been prepared in order to provide easy inroads to applications that may help you engage your advisee population. The authors have been utilizing these applications for a significant majority of the past three years and have found each of them to be an invaluable tool to connect with Millennial Generation students. Further, we’ve found that our maintenance of profiles in their environments, if exercised with caution, can lead to a greater sense of our relevance in the lives of our advisees, thereby making our counsel and advice more effective. The fact that you’ve participated in our Creative Utilization of Technology in Academic Advising Webinar leads us to conclude that you are of a similar mindset, so we offer you Web 2.0 as a meme to use to both anticipate and be at-the-ready to harness an ever-changing landscape of applications relevant to your roles as academic advisors.  

Web 2.0 – A Meme that Defines Technical Applications as Memes  

You will often find “meme” as the word of choice to describe what Web 2.0 is. Web 2.0 could just as easily have been labeled an “idea” or “framework” in which to view new Web technologies. “Meme,” however, is uniquely qualified in the English language for this job and its specific use is important in understanding not only what Web 2.0 is but how technology might be viewed pragmatically by all advisors. Think of a meme as an idea that self-propagates and evolves through a culture, its survival dependent upon both its power to be grasped intuitively and how much it lends itself to improvisational extrapolation. Jokes, recipes, songs, proverbs, gossip – all of these are examples of memes. People use them, enjoy them, put their own personal stamp or modification on them, and share them with other people.  

Web 2.0 is a meme because it is a framework with core ingredients that are grasped easily but not rigidly bounded – Web 2.0 as a definition or concept changes depending upon to whom it is you are speaking. One of the core ingredients of the idea of Web 2.0 (what Tim O’Reilly calls the “secret sauce”)¹, however, is that the applications developed in Web 2.0 style are themselves memes; they evolve and change as people use them. Instead of giving a person a version of a software package, you give them a service on the Web that they go to and use. The service itself is constantly being upgraded and repurposed with each new user.  

For example, Microsoft Word with the “track changes” feature is a Web 1.0 way of doing things (though it is not really a Web application per se). If you have Word on your computer and you want to create a document with a collaborator at another institution, you can make a draft in Word, turn on “track changes” and email the document to your collaborator. As your colleagues make edits and send the document back to you, their edits are visible to you and distinguishable from your own. The Web 2.0 version of this collaboration can be demonstrated by Googledocs—a web-based application the authors used to create this document. You and your collaborator(s) create online Google or Gmail accounts and start collaborating on the “Documents” page. The files you create actually look a great deal like a standard

word processing program – there are buttons you can click to make bullets and modify text as bold or italic, etc. Documents are saved online (so access is possible from any computer with internet connectivity) and share between collaborators—anyone sharing the document can log in to Googledocs, access the document you created and make track-able changes to it.

As an example of how this is Web 2.0, consider the following reality. You might be editing a document on Googledocs and notice that creation of tables is an available tool—this is remarkable only in the sense that it wasn’t a tool at your disposal the day prior. On a subsequent day, you notice the newly acquired ability to create spreadsheet documents as you would in Microsoft Excel—you simply logged in and there it was. Your next discovery is that you can create as many Googledocs as you want and save them in online storage folders. You can create grocery lists on your home computer and access them from your iPhone at the grocery store. You can create lists of your favorite 1980s music (with links to their videos on YouTube) in another Googledoc, share this with your friends and watch as they add to the list while sharing with their friends who also add to the list—the “viral” nature of the internet exposes itself to you in all its glory.

In each of these cases, Googledocs is a meme in the same way a food recipe is. A basic list of ingredients and cooking instructions is shared amongst friends who improvisationally adapt them to more creative results and re-share them with you and others. Is this different from creating a simple file, shared among collaborators with equal access to revision, reuse and repurposing? This is why Web 2.0 should help advisors become excited about technology – isn’t what advisors do in essence a meme in and of itself? We help students make meaning out of their education. The idea of “making meaning out of an education” instantly primes ideas in advisors’ heads, our students’ heads, and their parents’ heads. And these ideas change and evolve as students talk to each other, their families, and (hopefully most of all) their advisors. If we as advisors view technology in light of the Web 2.0 meme, we are absolved of any obligation of becoming technology gurus. We simply need to think of web-based applications like we do recipes, jokes or proverbs. We introduce applications into the advisor/advisee relationship and assess effectiveness. If using social media makes sense to our student population and us, continuation of the approach is self-evident. Effective tools will make their use immediately apparent (as happened with the authors and Facebook), and less helpful applications will fall into disuse.

In an effort to be good behavioral models, we have deliberately utilized several Wikipedia references in this manual, not because we are dedicated to it as a scholarly source of information, but because it represents many of the qualities of Web 2.0 applications we’ve found most useful in our experiences with this generation of advisees. Wikipedia, in fact, also provides a fairly well-encapsulated working definition of Web 2.0. “Web 2.0 is a trend in the use of "World Wide Web" technology and "Web design" that aims to facilitate creativity, information sharing, and, most notably, collaboration among users. These concepts have led to the development and evolution of web-based communities and web services, such as social networking sites, wikis, blogs and “folksonomy.” There is a lot more involved with Web 2.0 than we rely upon as regular tools in the advising process, however; the collaborative and creative approaches to the creation and sharing of knowledge can’t be overlooked in assessing importance and utility. Whether it’s a student sharing related experiences in a comment on an advising blog posting, or a group of students using IM as a virtual study group, the connectedness and accessibility offered by web-based applications is significant. So off we go on an exploratory mission to the bold new world of Web 2.0 applications in advising.

Facebook for the Technologically Challenged Advisor

Perhaps the most omnipresent online application in the lives of our collective student population is the social networking site known as Facebook. As this site has shown itself to be one of the authors’ most valuable tools, we thought it the appropriate place to begin. Here is what Wikipedia says about Facebook:

Facebook is a social networking website that launched on February 4, 2004. The website is free to use and allows users to join one or more networks, such as a school, place of employment or geographic region in order to easily connect with other people in the same network. The name of the website refers to the paper facebooks that depict members of a campus community that some American colleges and preparatory schools give to incoming students, faculty, and staff as a way to get to know other people on campus. Mark Zuckerberg founded Facebook while still a student at Harvard University. Website membership was initially limited to only Harvard students, but was later expanded to include any university student, then later to high school students, and finally, to anyone aged 13 and over.

The website has more than 64 million active users worldwide. From September 2006 to September 2007, the website's ranking among all websites, in terms of traffic, increased from 60th to 7th, according to Alexa. It is also the most popular website for uploading photos, with 14 million uploaded daily. Due to the website's popularity, Facebook has met with a certain amount of criticism and controversy in its short lifespan because of privacy concerns, the politics of its founders, and censorship issues.

Although Facebook and MySpace are both popular social networking sites, Facebook is extremely popular among college students and MySpace seems to have captured more of a high-school-aged audience. Further, Facebook seems to be the most popular for students in college and universities around the world. A reported 74% of college females and 60% of college males rate Facebook as their most visited website, while at Virginia Commonwealth University a recent survey of nearly 5000 students found Facebook preferred over MySpace 61% to 18%.

Downloading the Software
To get started, simply go to www.facebook.com and register your email address. You will then be able to create your own profile by following the prompts.

Getting Started
This is your page, so be creative and do whatever you want with it. What do you want to accomplish with your Facebook site? Do you simply want a place where students, colleagues and friends can get to know you better or do you want to use this site for communicating important information to students and colleagues? If your Facebook page will be accessible by a wide audience, including students, be careful to make everything here appropriate for viewing by all. You can make your Facebook page available to anyone, whether they are your friends on Facebook or not, or keep it private to only your friends in the network. This and other security options will be available to you when you set up your initial profile.

Adding Friends on Facebook
There is a search engine on Facebook that you'll use to find any friends or acquaintances you may have on the network. Once you find someone you would like to invite to be your friend, simply select "Add to

---


5 Ibid., Retrieved on 2008-03-14.

Friends™ on the right side of their picture. That person will be notified the next time they log in and asked to confirm you as a friend (or not). Your list of friends will be available to you from your profile page.

Editing Your Profile
You can include as much, or as little, information about yourself and your family on your Facebook page as you wish. The site gives you easy-to-use prompts for uploading pictures and videos, editing your personal information, and joining groups. You can also create groups for targeted people to join.

Groups on Facebook
Organizations can create Facebook pages with information about their group and activities. People on Facebook can join groups so they have access to the information and participants can be targeted for delivery of useful advising information. Some groups are simply fun while others may be meaningful and provide valuable information. You can join and/or create as many groups as you wish.

The Wall on Facebook
The "wall" is a section on everyone's Facebook page—you can write messages to friends and they can write back to you on your wall. It's similar to sending an email, but this message appears on your friend's wall, for all to see. You can also use the wall to post important messages you want everyone to see about yourself or your work. For example, you could post the phone number or Web site for your students to use to make appointments with you and leave that post up and visible all the time.

Email and IM From Facebook
Since most people record their email address and IM screen name on their profile, you can easily attain these bits of contact information. Various instant message services link right off of Facebook profile pages with a simple click on the user's screen-name. Facebook has also recently created its own IM application—you can now IM friends by going to your Facebook site.

Other Features
There are so many new features added to Facebook every week that it is sometimes overwhelming to manage them. Many of these features are being created and added by outside developers. For example, with the "Where I've Been" feature you can create a map showing all of the places you've traveled and all the locations you dream of going. You can determine your best or "top friends," send cyber gifts, or utilize the "Marketplace" to buy and sell things. The "Events" option allows you to create, advertise and invite "friends" to an event like a lecture, a chat, a party, etc. You can play games with your friends and take quizzes on a variety of topics, you can share links to interesting websites, share your musical tastes with others—art museums have even begun using Facebook application to share their collections on-line. It's your choice how many—if any—of these extra features you want to get involved with. It is a bonus to see the kinds of things that students are doing with Facebook even if you don't participate in all of these activities. By engaging students in this environment where they explore and socialize, we have the opportunity to socialize them into viewing their educational possibilities as an equally interesting and intriguing endeavor. Have fun with it if you have time!

How Can You Use Facebook in Advising?
Facebook can be used in a variety of ways depending on your own goals and philosophies:

- Provide contact information to your students and some information for them to get to know you better
- Find students who are missing in action
- Provide important advising and academic information for your students and other advisers
- Facebook's Homepage "News Feed" can be useful as a sort of RSS feed
- A forum for important discussions
- At the very least, your Facebook page can be an example to students for how to use social networking responsibly
What Are You Worried About?
We were concerned that students might resent representatives of "The Institution" being on their social space and weren't sure how much of our personal information we wanted to share with everyone. We discovered that neither of these concerns was warranted—students don't care if we use their space as long as we aren't intrusive. We try to be always sensitive that this does not represent the university to them, but rather a place they socialize—we are the guests in their environment and must ask them to let us in. Not being intrusive while still providing valuable academic information to students is a tightrope walk sometimes. You can allow students the opportunity to friend you first by simply letting them know you are on Facebook and that you would accept their friendship if they ask. This is Terry's approach, while Art will befriend all his students, assuring them he's not there to spy or list prohibited behaviors—he is rarely refused. We all abide by the unstated policy to not address Facebook activity unless we see things that are potentially damaging or dangerous. For example, you may not want to get as personal as to say, "I saw on Facebook that you and Jen broke up last week." You may rather like to keep your interactions impersonal and advisory; cautioning and reminding students, for example, that employers, parents and others may check Facebook pages and that removal of questionable pictures or statements from their site is probably wise. Perhaps a happy medium would include sending birthday messages and other personal sentiments to students letting them know you are there and that you care about them, but not that you are overly interested in every facet of their personal lives. Just get registered and give Facebook a try and then decide if it is worth your time.

Instant Messaging for the Technologically Challenged Advisor

Here is what Wikipedia says about Instant Messaging:

"Instant Messaging" (IM) and chat are technologies that facilitate near real-time text based communication between two or more participants over a network. It is important to understand that what separates chat and instant messaging from technologies such as e-mail is the perceived synchronicity of the communication by the user - chat happens in real-time before your eyes. For this reason, some people consider communication via instant messaging to be less intrusive than communication via telephone. However, some systems allow the sending of messages to people not currently logged on (offline messages), thus removing much of the difference between Instant Messaging and e-mail.

Instant Messaging allows instantaneous communication between a number of parties simultaneously, by transmitting information quickly. Some IM systems allow users to use webcams and Microphone, which made them more popular than others. Due to this feature users can have a real-time conversation. In addition IM has additional features such as: the immediate receipt of acknowledgment or reply, group chatting, conference services (including voice and video), conversation logging and file transfer. IM allows effective and efficient communication, featuring immediate receipt of acknowledgment or reply. In certain cases Instant Messaging involves additional features, which make it even more popular—video-messaging sessions so you can see the other party, or audio-messaging to talk directly for free over the internet are examples of enhanced IM.

It is possible to save a conversation for later reference. Instant messages are typically logged in a local message history which closes the gap to the persistent nature of e-mails and facilitates quick exchange of information like URLs or document snippets (which can be unwieldy when communicated via telephone)." 7

Although there are several text-messaging software packages available for free, one of the most commonly used packages is AOL Instant Messenger. You can survey your students to determine how

many use IM and what software package they prefer. New applications are being developed all the time, so it is important to check frequently with your students to see if many of them are gravitating toward a newer technology for instant communication. In most cases, it is not possible to “talk” to individuals using different software packages than your own, however, a few applications have been developed that communicate between different platforms (such as www.meebo.com, www.pidgin.com, www.skype.com or www.trillian.com).

Downloading the Software
Once you have determined the best IM application to use in your setting, you must download the software. For AOL Instant Messenger, simply access www.aim.com and you will find the link to "Download AIM”—this is a free download.

Creating Your Screenname
After installing the AIM program, you will need to create your own screenname. You may use your actual name to make it easier for students to recognize you or you may want be creative and develop something fun. You can also create a screenname for your advising center rather than for an individual. If you plan to use IM for personal reasons at home or away from work, maintaining both a professional and private screenname is advisable. Alternatively, there are ways to manage “away messages” so you can be online but appear “invisible” to your students—we’ll talk more about this below.

Getting Started
After creating your screenname, you’re ready to start sending messages to your “buddies”—those with whom you regularly communicate. Adding screennames to your “buddy list,” makes these contacts readily available to you for IM-ing with the speed of a “double-click.” To add screennames, simply go to the “Edit” menu at the top of your AIM screen and select "Add Buddy" and follow the prompts. It’s not possible to search for people using AIM, so you’ll need to solicit screennames from people with whom you want to communicate and manually add them to your buddy list. The person you add must then confirm that s/he wants to be your buddy. You may similarly receive requests from others to be their buddy—you can accept or reject these offers according to your own professional boundaries. We’ve found it “best practice” to allow students the option of using this form of communication rather than making it compulsory.

Sending Messages
Once you’ve added buddies to your list, you’ll be able to IM them by double-clicking screennames from that list. Type your message in the bottom dialogue box and hit the “enter” key or click “send.” You’ll receive messages from your buddies through the same screen—your computer will notify you by blinking or making a sound when a message has been received. To reply to a message, simply click in the dialogue box at the bottom, type your message and hit “enter” or click “send.”

Away Messages
A unique feature of IM is the ability to know when buddies are online, away from their computer, available for messaging, etc—you’ll see a list of your buddies and their online status in your main AIM window. By selecting “Away Messages” from the Edit menu, you can create different messages to signify your own online status. For example, you could simply have a message that says "Available" or "Away" or you could personalize it more and say "I am with a student now and will get back to you as soon as possible," "I'm away from my computer right now" or "at a meeting." Students will often make these statements very personal, "Watching All My Children" or "Hanging with my peeps," thus using their on-line status to share a bit about themselves or their current emotional state.

Managing Buddies
You can organize your “buddy list” using separate categories for student populations, colleagues, and family or non-work friends. Because people can choose whatever screenname they wish (and can sometimes be very creative in doing so), it can be difficult to identify your “buddy’s” true identity. This is easily remedied by selecting a screenname and clicking on “Edit Selection” in the “Edit” menu or by right-clicking on the screenname and then selecting “Edit Buddy.” By entering the person’s given name in the box titled "Nickname” and selecting “nicknames” from the “View” menu in the AIM window, your buddies’
actual names will be displayed rather than their screennames. You can supply additional information in the "Edit Buddy" window. By filling in additional boxes in the edit screen with cell phone numbers and email addresses, you can re-purpose the AIM program to gain rolodex-like functionality. Removing contacts from your buddy list is as easy as right-clicking on their screenname/nickname and selecting "Delete Selection" from the menu.

Documenting IM Contacts
Given the importance of documenting contact with student populations, we've found the following record keeping options helpful. You can copy entire IM conversations or paraphrase your own notes into any note-keeping system or word processing program. Also, you're able to set the AIM program to automatically save IM conversations. This feature can be found under "Settings" on the "Edit" menu of your AIM application—there is a tab entitled "Logging" on which you select your preference. You can enable the program to log all IMs and/or Chats and designate where on your computer this log is to be stored. The lengths to which you go in logging all or some of your IMs are, of course, up to you.

Setting Up Chats
IM-ing more than one person is referred to as "Chatting" in AIM—this might come in handy if you want to chat with a group of students or colleagues. Simply IM one person and then select "Buddy Chat" under the "Actions" menu and enter the screennames of the others you want to invite to join the chat. It can be challenging to facilitate a group discussion this way as people can be typing messages over one another, but it can also be quite fruitful and engaging for the student population—most are gifted at multi-tasking in this manner.

Sending Files via AIM
When you have a message box up to send to a buddy, the menu at the bottom of the box allows you to send pictures, files, etc. Simply follow the prompts. This can be a useful mean of delivery when time is of the essence with a colleague or to save a student a walk-in appointment to retrieve a routine form.

Creating Your Expression—the Wonderful World of WeeMees
When you send an IM, the receiver sees an image you've chosen to represent you—your "Expression." You can customize your image by finding and selecting the paintbrush icon on a sent message (lower right side), or selecting "Expression" on the "Edit" menu. This will take you to the AIM Web site where you can create your expression—whether you choose a simple icon or animated avatar⁸, this is the digital "expression" of your state of mind, some deep social commentary or even a light-hearted joke. AIM calls avatars your WeeMee (or I guess it would be your WeeYou). You can create your WeeMee and an animated background at the WeeWorld site: www.weeworld.com. You've your choice of hair, clothing, props, backgrounds, sounds and expressions from this site. Be mindful of the addictive qualities of a site that allows you to redefining yourself with limitless possibilities!

What Can You Use IM For in Advising?

- Quick advising questions with students
- Staying in touch with and/or tracking down "lost" students, knowing what they are up to, letting them know what you are up to, etc.
- Intake advising -- students IM a common advising screenname where an adviser is on duty to answer questions
- To let advisers know when student appointments have checked in

---

• To communicate with others in your office when you have a question or need assistance
• To collaborate on projects with colleagues internal and external to your office

What Are You Worried About?
When the authors first began using IM in advising a few years ago, we had concerns. Will students find us intrusive? Will students resist talking to "professionals" through this informal medium? Will we be able to understand the abbreviations and special text language young people use for IM? Will we be overwhelmed with IM’s throughout the day? After implementation and informal assessment, we determined that our concerns and fears were unfounded. Some students will welcome the ability to reach you via this convenient method and others will not—and that’s OK. Students don't care if you ask them to explain an abbreviation (they’ll likely include an “LOL” in their explanation—"laugh out loud"). Neither have we been overwhelmed with IMs on a daily basis. Even if you don’t feel comfortable communicating with students in this manner, IM can be very useful for collaborating with colleagues on projects. It is arguably irresponsible to NOT give Instant Messaging a try! Remember, a mere ten years ago we were asking these same questions about email and advising!!

Podcasting for the Technologically Challenged Advisor

Here is what Wikipedia says about Podcasts:

A podcast is a collection of digital media files, which is distributed over the Internet, often using syndication feeds, for playback on portable media players (iPods) and personal computers. The term podcast, like broadcast, can refer either to the series of content itself or to the method by which it is syndicated; the latter is also termed podcasting. The term podcast should not be used to describe individual files. The host or author of a podcast is often called a podcaster.

The term is a portmanteau of the words "iPod" and “broadcast,” the Apple iPod being the brand of portable media player for which the first podcasting scripts were developed. These scripts allowed podcasts to be automatically transferred to a mobile device after they are downloaded.

Though podcasters' Web sites may also offer direct downloading or streaming of their content, a podcast is distinguished from other digital media formats by its ability to be syndicated, subscribed to, and downloaded automatically when new content is added, using an aggregator or feed reader capable of reading feed formats such as RSS (Really Simple Syndication) or Atom.⁹

So, What the heck is an Aggregator?
An aggregator is a software program or web application that aggregates, or collects, blogs, podcasts or news headlines into one location for easy reading/viewing/listening. It works a lot like your email program in that it automatically collects any new installment of the blog or podcast to which you have subscribed. Many webmail services offer them (such as google) as part of a basic email account, however, the collected media are not filtered into your email inbox but housed on a separate web page.

Getting Started
You'll need to obtain software to capture the digital audio (or video). Some newer Macs come with software known as GarageBand, but there is a great free product on the market for PC users called Audacity. It’s remarkably easy to record (just plug a microphone into your computer and click "record"), and editing is a snap, too. If you have a webcam, you might also like to create a video podcast (sometimes referred to as a vidcast). Most cameras come equipped with video-capturing software, but

products such as Camtasia allow for great editing capabilities that are only slightly more complicated than "Audacity" is for audio.

Once you've created the content, you need to find a way to "push" it into the students' environment. A growing number of Universities are partnering with iTunes by creating institutional identities with iTunesU—the iTunes store dedicated solely to "pushing" university-related podcasts. If your institution is among these, then you've built in vehicle for distribution of your podcast. If not, you'll need to find a host or host it on your web page—in both cases adding an RSS tag for subscription purposes. This is where the steps can become complicated, as the RSS tags are written in computer code (it's a long story involving A LOT of acronyms). Cutting to the chase, there exist a terrific number of hosting sites—some free, some not. I found www.gcast.com to be an exceptionally easy format—free and easy to use; you can even record your scripts by phone!

All that having been said, I rely primarily on Facebook, YouTube and iTunesU. I also utilize a very basic webcam and create video podcasts—a slight twist on the more common audio podcast. I find the three environments listed previously to be the most effective at pushing content into the environments my caseloads frequent most—your situations may or may not be different and your caseloads may or may not respond as mine did. It's best to identify the uniqueness of your advisees and speak directly to it, rather than utilizing an archetypical approach and focusing on presumed universals.

**Downloading the Software**

The only program you'll really need to download in order to get started would be one to capture audio and render it as an MP3 file. For this purpose, I think Audacity (http://audacity.sourceforge.net/) is the best. This download will take but a few minutes and it's the most useful program I've ever encountered—and it's free! After you've downloaded the program and hooked up your microphone, you'll need to create profiles anywhere you want to be hosting your podcast. With Gcast (gcast.com), you'll need only create an account and start uploading or telephone-recording content.

**What Can You Use Podcasts for in Advising?**

Your presenters have been using podcasts—both audio and video—for a few semesters now and have found them to be an excellent supplemental source for the delivery of "informational advising" such as the following:

- general announcements of approaching deadlines and important dates
- publicizing upcoming events
- delivery of course materials and lectures
- reminders of university policy around early alert and registration periods
- students share their experiences being a student with prospective and newly admitted students
- students share their experiences with exploring majors with other undecided students

**What Are You Worried About?**

Our primary concern upon implementation was one of time management and fear that this would add exponentially to the time it took to perform our other advising duties. However, with each recorded and edited installment or script, we found that production and delivery time could be as little as five minutes. What is the payoff? Are students downloading or watching/listening to the podcasts? Are students learning anything from this medium that they would not have learned through another method? These sound to us like great assessment or research questions for future studies!
Wikis and On-line Collaboration for the Technologically Challenged Advisor

Here is what Wikipedia has to say about…well itself, really:

A wiki is a page or collection of Web pages designed to enable anyone who accesses it to contribute or modify content, using a simplified markup language. Wikis are often used to create collaborative websites and to power community websites. The collaborative encyclopedia Wikipedia is one of the best-known wikis. Wikis are used in business to provide intranets and Knowledge Management systems. Ward Cunningham, developer of the first wiki software, WikiWikiWeb, originally described it as “the simplest online database that could possibly work.”¹⁰

We’ll discuss different applications of wikis in a moment, we just wanted to take a minute and mention an alternative approach to on-line collaboration—its name is Google Documents (google docs). The reason it’s perhaps a more viable alternative for advising scenarios is that its end goal isn’t a web page but rather a document, spreadsheet or powerpoint-like presentation. Google Docs essentially provides a web-based workspace that looks considerably like a word processing, spreadsheet or powerpoint presentation program. Documents are saved to a web browser, can be shared with multiple collaborators and can be worked on simultaneously.

Getting Started – Wikis
You’ll need to decide upon your desired final result—web page, document, presentation—and choose the appropriate web-application to host your collaboration. If you choose a wiki, there are various “Wiki Farms” (web sites that host your wikis)—the list is insanely long, so we’ll focus in on one we’ve found to be very user-friendly and highly functional. Wetpaint.com is a free host for you to “create a page about anything you love” as their title banner indicates. It, like google docs, is in a WYSIWIG format (What You See Is What You Get), so you simply type the text you want and it appears just the way you typed it—no need to learn HTML code or any other complicated markup language. You need only create a profile, start creating pages and share them with whomever you want to collaborate or communicate. Viewers would simply see the page—collaborators would also see an “easy edit” button near the top of the page. The easy edit feature turns the web page window into a Microsoft Word-like work space with all the same functionality of the word processing program.

Wetpaint allows you to create multiple pages and sub-pages within wikis—you can use this structure to create menus of content. Imagine a wiki being used as an A to Z reference for faculty advisors—there might be a main page with sub-pages for Academic Warning, Financial Aid, Major Changes and Study Abroad for example. Wetpaint also has a member listing and a “To Do” list feature, allowing moderators of the wiki to establish timelines and monitor productivity. There is a function allowing you establish links to guide research on the project. If thinking about applications to employ with student populations, perhaps the Discussion Board could be used for Frequently Asked Questions or clarifications of expectations—and the photo gallery as a way to memorialize aspects of the project. Again, the possibilities are limited only by your creativity.

Getting Started – Google Documents
Google Documents is a bit more straigt-forward. You’ll need a gmail account in order to access the Documents application. Then, you simply create a new document (or spreadsheet or presentation) for each project. You can upload an existing document of the same type (i.e. Microsoft Word, Excel or Power Point) or simply create one in the browser. Once the document is created, you decide on sharing options—either with “collaborators” or “viewers”—and get to work. The same functionality that exists in the desktop software packages exists in the web browser—it couldn’t be less complicated. Viewers would, again, only see a finished document while collaborators would see editing tools at their disposal.

What Can You Use Wikis For In Advising?
Because much of the flow of information in an advisor/advisee relationship necessarily needs to be “us to them,” the use of wikis can be tricky. This is not to say that a paradigm shift on certain topics is impossible to consider. We need only recall the YouTube sensation created by Kansas State University’s Michael Wesch, “A Vision of Students Today”—it was created through the use of a wiki to which over 200 of his students contributed. If you haven’t seen that yet, you’ll definitely want to check it out—simply log onto YouTube, search for Michael Wesch and look for the video. You should actually spend some time looking at all of his videos.

So, what can our students tell us?
- RateMyProfessor.com?
  - Take a bit more control – make it more useful
- Peer Advising
  - Students speaking to students = more “buy in”
- Community Engagement – Extra-Curricular Activities
- Frequently Asked Questions
  - Frequently asked, but answered only once
- Advisor to Advisor Collaborations
- Living Training Document
  - reference page for faculty advisors on your campus

Blackboard for the Technologically Challenged Advisor
Here is what Wikipedia says about Blackboard Learning System.

The Blackboard Learning System is a Web-based server software platform. Features include course management, a customizable open architecture, and a scalable design that allows for integration with student information systems and authentication protocols. It may be installed on local servers or hosted by Blackboard ASP Solutions. Its main purposes are to add online elements to courses traditionally delivered face-to-face and to develop completely online courses with few or no face-to-face meetings.11

It’s important to note in the case of Wikipedia’s entry on the Blackboard Learning System, that it is a non-sourced entry on the free, web-based encyclopedia, and therefore arguably less than relevant. Advisors might take exception to the final sentence with its suggestion that one of the goals of the system is to reduce or replace the face-to-face learning relationship and view Blackboard’s integration into the advising process as similarly suspect. However, one needs necessarily recall, in our assessment and programming development stage, the supplemental nature of all the tools the authors have recommended in this document. That being said, the suite of tools the course management system offers is tremendously useful in the advising process.

Courses vs. Organizations
The Blackboard Learning System seems primarily designed to organize and deliver course materials for classes—the “Grade Book” and “Assignments” features are testament to this observation. However, the possibility to organize your advisees into an ongoing “Organization”—one that is continuous and need not be copied from one semester to the next—provides many effective tools for the technology-friendly advisor. Advisor’s caseloads can be loaded into an “Organization” as students would be to a “Course”

and all features available to instructors become tools for communicating with and delivering programming to advisee populations.

Announcements
The “Announcements” function on Blackboard can be very useful for the delivery of bulletin-like advising information—reminders of approaching deadlines, changes in office hours, even the schedule for special events. Your university’s portal may also post blackboard announcements, increasing your “circulation” by including the announcement on the portal page of any every member in your organization or course.

Documents
The “Documents” function in the blackboard environment is ideal as a repository for an “advising toolkit” if you like. The authors have used this function for everything from schedule planning documents, to GPA calculators and calendars for student download—one of them has even uploaded orientation power points to the environment in the past.

Communication
The “Communication” tool is possibly the most replete set of functions on the system. Whether it’s email you’re after, the WIMBA Live (on-line) Classroom or the Podcaster, you’ll find the tool here. I’ll pass on discussing functions that have their own links within the system (such as the “Announcements” we’ve already discussed and the “Discussion Board” which we are about to), and proceed right to the following:

Email
You can email your entire caseload, or specifically defined populations (groups) within your membership with the touch of a button—no hassle in copying and pasting multiple addresses. One drawback is your inability to really memorialize the fact that you’ve sent the email—Blackboard has no “Sent Mail” folder. The “return receipt” function is possible, but has its limitations.

Live Classroom
Arguably the authors’ favorite feature of blackboard, this is the on-line classroom (any of you who have “Attended” a NACADA Webinar will be familiar with this feature). You can push audio, video, power points and web browsing into this room as your students access the information remotely in real time. Your advisees need only be equipped with a sturdy internet connection, a pair of headphones or a good set of speakers. It also alleviates the need to secure lecture space for the delivery of programming appropriate to an online environment. You can “archive” (or record) your first presentation of any workshop or lecture and refer students to it without needing it redelivered.

Voice Boards & Emails
When there’s just too much to type, Blackboard allows you to send voice email or post “Voice Boards” (audio Discussion Board) messages.

Wimba Podcaster
This function affords you the option of a free host for your podcast, complete with a built-in RSS feed. All you need to get started with any of the four video/audio content delivery functions is a web cam/microphone (many of the newer models combine both into one piece of hardware) with which to record the digital content.

Discussion Board
This feature provides a great home for anything from student journals, to blog-like discussions that you create with the specific goal of encouraging interaction and collaboration. One of the authors is an advisor of undeclared populations and has used forums to start discussions between students with the same potential or intended major. The “Discussion Board” now links directly to the grade book in a course environment, allowing for trouble-free assessment in one window.

Tools
Though there are many tools under this tab, the authors have found the “Digital Dropbox” to be one of the most useful. As the name suggests, it allows for the electronic delivery of written assignments. Rather
than clogging your inbox with email attachments, the dropbox allows for quick download of assignments—you can even save them right to your hard drive.

This list of useful Blackboard functions amounts merely to a summary glance at all the possibilities the system boasts. For a more complete list, we recommend you consult with your university’s Blackboard support personnel—they’re bound to have training modules and easy to follow, self-paced guides to everything we’ve skipped with this cursory glance.

**Conclusion**

The preceding has been a concise explanation of a handful of tools that the authors have found useful in engaging our predominantly Millennial-generation advising populations. It is neither a comprehensive or even exhaustive collection of tools—nor was it intended to be. We encourage you to let this serve as a “jumping off point” for your own exploration of all the World Wide Web has to offer—never be afraid to adaptively re-use tools at your disposal if the end result is increased levels of engagement with your advising populations. Everything we’ve covered has been included with ease and efficiency in mind; we hope you’ve identified ways in which to apply some of these tools. We’re also offering ourselves as contacts in case you get hung up in the process of downloading, creating content, or even trying to imagine ways in which your office or personal advising approach might benefit by the adoption of these technologies.

Terry Musser  
The Pennsylvania State University  
txm4@psu.edu  
AIM: immuss2  
Facebook: http://www.facebook.com/profile.php?id=9392862

Art Esposito,  
Virginia Commonwealth University  
ajesposit@vcu.edu  
AIM: vcuesposito  
Facebook: http://www.facebook.com/profile.php?id=25510511

Wes Lipschultz  
University of Pittsburgh  
wlipschultz@sis.pitt.edu  
AIM: Abraxas1022  
Facebook: http://pitt.facebook.com/profile.php?id=602600623
Technology Glossary

Aggregators
Aggregators reduce the time and effort needed to regularly check websites for updates, creating a unique information space or "personal newspaper." Once subscribed to a feed, an aggregator is able to check for new content at user-determined intervals and retrieve the update. The content is sometimes described as being "pulled" to the subscriber, as opposed to "pushed" with email or IM. Unlike recipients of some "pushed" information, the aggregator user can easily unsubscribe from a feed.

Avatar
A computer user's representation of her- or himself. It can be a picture, symbol, text construct or even an animated digital image.

Blog
A blog (a contraction of the term "Web log") is a web site with regular entries of commentary, descriptions of events, or other material such as graphics or video. Entries are commonly displayed in reverse-chronological order. Blog can also be used as a verb, meaning to maintain or add content to a blog.

Feed
A feed, or Web feed, refers to some sort of content that has been syndicated for collection by an aggregator—be it a blog, podcast or even an internet-based news report (news feed). Wikipedia has a good page on this if you’d like to truly try to understand the complexity of the issue at this address: http://en.wikipedia.org/w/index.php?title=Web_feed&oldid=250666367

Markup Language
A Markup Language is a series of text annotations that gives instructions for the formatting and appearance of text. The most relevant markup language to our discussion is HTML (Hypertext Markup Language) code—that which is used in creating World Wide Web pages.

Online Social Networks
Online communities of people who share interests or who are interested in exploring the interests of others. Most social network services provide a variety of ways for users to interact. Examples of online social networking sites include Facebook and MySpace.

Podcast
A podcast is a series of audio or video files which is distributed over the Internet by download, to portable media players (like iPod) and personal computers. Though the same content may also be made available by download or listening/viewing on a personal computer or apple computer, a podcast is distinguished from other digital-media formats by its ability to be subscribed to and downloaded automatically when new content is added.

Push/Pull Technology
Pushing and pulling in our conversation refers to the dissemination and retrieval of information. You push information when you email your students or post a blog or podcast. The difference comes into play in how the information is retrieved. In the email scenario, the recipient has no choice but to receive the data. When you push a blog or podcast, on the other hand, the recipient only gets the data if they go to it on your host site or if they have subscribed to your feed—their aggregator pulls the information to them.

Virtual Worlds
A virtual world is a computer-based simulated environment intended for its users to inhabit and interact via avatars. Communication between users has ranged from text, graphical icons, visual gesture, sound, and rarely, forms using touch and balance senses.
RSS
In various versions of this formatting tool, RSS has stood for Rich Site Summary, RDF Site Summary and most recently Real Simple Syndication. For the purposes of our discussion, it refers to the formatting on a Web-published document that includes a mark-up language allowing the piece content to be syndicated. For a completely understandable explanation, Find Lee Lefever’s “In Plain English Series” on YouTube or commoncraft.com.

Virtual Worlds
A virtual world is a computer-based simulated environment intended for its users to inhabit and interact via avatars. Communication between users has ranged from text, graphical icons, visual gesture, sound, and rarely, forms using touch and balance senses.

Wiki
Wiki is a piece of software that allows users to freely create and edit web page content using any web browser. Wiki supports hyperlinks and has a simple mechanism for creating new pages and connections between internal pages.

Wiki Farm
Web site designed to host your wikis.